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Graphics

PLOT Linear plot.
PLOT(X,Y) plots vector Y versus vector X. If X or Y is a matrix,
then the vector is plotted versus the rows or columns of the matrix,
whichever line up. If X isascalarand Y is a vector, disconnected
line objects are created and plotted as discrete points vertically at
X.

PLOT(Y) plots the columns of Y versus their index.
If Y is complex, PLOT(Y) is equivalent to PLOT(real(Y),imag(Y)).
In all other uses of PLOT, the imaginary part is ignored.

Various line types, plot symbols and colors may be obtained with
PLOT(X,Y,S) where S is a character string made from one element
from any or all the following 3 columns:

b Dblue . point - solid
g green 0 circle . dotted
r red X X-mark -.dashdot
C cyan +  plus -- dashed
m magenta *  star (none) no line
y yellow S square
k black d diamond
w  white v triangle (down)

A triangle (up)

< triangle (left)

> triangle (right)

p pentagram

h  hexagram
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For example, PLOT(X,Y,'c+:") plots a cyan dotted line with a plus
at each data point; PLOT(X,Y,'bd") plots blue diamond at each data
point but does not draw any line.

PLOT(X1,Y1,S1,X2,Y2,52,X3,Y3,S3,...) combines the plots defined by
the (X,Y,S) triples, where the X's and Y's are vectors or matrices
and the S's are strings.

For example, PLOT(X,Y,'y-",X,Y,'g0o") plots the data twice, with a
solid yellow line interpolating green circles at the data points.

The PLOT command, if no color is specified, makes automatic use of

the colors specified by the axes ColorOrder property. By default,

PLOT cycles through the colors in the ColorOrder property. For
monochrome systems, PLOT cycles over the axes LineStyleOrder property.

Note that RGB colors in the ColorOrder property may differ from
similarly-named colors in the (X,Y,S) triples. For example, the
second axes ColorOrder property is medium green with RGB [0 .5 0],
while PLOT(X,Y,'g") plots a green line with RGB [0 1 0].

If you do not specify a marker type, PLOT uses no marker.
If you do not specify a line style, PLOT uses a solid line.

PLOT(AX,...) plots into the axes with handle AX.

PLOT returns a column vector of handles to lineseries objects, one
handle per plotted line.
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The X,Y pairs, or X,Y,S triples, can be followed by parameter/value pairs to
For example,

specify additional properties of  the lines.
PLOT(X,Y,'LineWidth',2,'Color',[.6 0 0]) will create a plot with a dark red line

width of 2 points.

Examplel:
X = -pi:pi/10:pi;
y = tan(sin(x)) - sin(tan(x));
plot(x,y,'--rs','LineWidth',2,...
‘MarkerEdgeColor','k',...
‘MarkerFaceColor','g,...

‘MarkerSize',10)
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Fig.(1) examplel.
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Example2:

X = -pi:pi/10:pi;
y =sin(x) ;
plot(x,y,--rs','LineWidth',2,...
‘MarkerEdgeColor','k',...
‘MarkerFaceColor','d,...
‘MarkerSize',10)

0.8 ,l' = -
4 \\
0.6 H | 1

0.2

-0.4 -

06 a) u |

[4]



University of Technology
Laser and Optoelectronics Engineering Department

Computer Applications

Image processing in MATLAB

* Require MATLAB to be installed with image processing toolbox
+ Digital image is composed of array of pixels — array of numbers (Matrix)
» Process on image is easily handled by MATLAB

Image Formats Supported

« BMP
+ JPEG
+ PNG
« TIFF
« PCX
+ HDF

etc.

Working formats in MATLAB

» Binary image (0=black, 1=white)
 Intensity image (gray scale image)
* Indexed image (color image)

+ RGB image (true color image)

« Multiframe image

How to read image files
imread(‘file name’)

Example :

>> imread(‘imagel .jpg’);

>> a = imread(‘image2.jpg’);
>> b = imread(‘image3.bmp’);

[1]
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Image file information's.
imfinfo (‘image file’)

EX.
>> imfinfo (‘test image.png’)
ans =
Filename: ......................
FileModDate : .................
Filesize : ...,

How to write image files
imwrite(var,‘file name’, ‘format”)
Example :

>> a = imread(‘imagel.png’);

>> imwrite(a, ‘image2.jpg’, ‘jpeg’);
>> imwrite(a, ‘image3.bmp’, ‘bmp’);

How to display image
imshow(image_var)
or figure, imshow(image_var)

Example:

>> a = imread(‘imagel.png’);
>> 3

ans =

>> imshow(a);

>> figure, imshow(a);
(diff. window to display image)

[2]



University of Technology
Laser and Optoelectronics Engineering Department

Computer Applications

Example: Crop for a part of image

>> a = imread(‘imagel.png’);
>> imshow(a) % display a

>> for i=1:50
for j=1:50
for k=1:3
b(i,j,k) = a(i,j,k);
end
end
end

or
>>p =a(1:50, 1:50, 3);
>> figure, imshow(b) % display b on another window

Creation of function file

file>new
function y = sum1(n)
y=0;
fori=1:n
y=y+i
end

Save as suml.m

Calling this function
>>sum1(10)
ans =

[3]




University of Technology
Laser and Optoelectronics Engineering Department

i)
! 9V0 diw Saaly

Computer Applications

Integration
INT Integrate
INT(S) is the indefinite integral of S with respect to its symbolic variable as defined by SYMVAR. Sisa
SYM (matrix or scalar). If S is a constant, the integral is with respect to 'x'. INT(S,v) is the indefinite
integral of S with respect to v. v isaalar SYM.
INT(S,a,b) is the definite integral of S with respect to its symbolic variable from a to b. a and b are each
double or symbolic scalars. INT(S,v,a,b) is the definite integral of S with respect tov fromato b.

Examples:

syms x x1 alpha u t;

A = [cos(x*t),sin(x*t);-sin(x*t),cos(x*t)];
int(1/(1+x"2))

returns  atan(x)

int(sin(alpha*u),alpha)
returns  -cos(alpha*u)/u

int(besselj(1,x),x)
returns  -besselj(0,x)

int(x1*log(1+x1),0,1)
returns 1/4

int(4*x*t,x,2,sin(t))
returns  -2*t*cos(t)"2 - 6*t

int([exp(t),exp(alpha*t)])
returns [ exp(t), exp(alpha*t)/alpha]

int(At)

returns  [sin(t*x)/x, -cos(t*x)/x]
[cos(t*x)/x, sin(t*x)/X]

[1]
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DIFF Difference and approximate derivative.

DIFF(X), for a vector X, is [X(2)-X(1) X(3)-X(2) ... X(n)-X(n-1)].

DIFF(X), for a matrix X, is the matrix of row differences,

[X(2:n,:) - X(1:n-1,))].

DIFF(X), for an N-D array X, is the difference along the first non-singleton dimension of X.
DIFF(X,N) is the N-th order difference along the first non-singleton dimension (denote it by DIM).
If N >= size(X,DIM), DIFF takes successive differences along the next non-singleton dimension.
DIFF(X,N,DIM) is the Nth difference function along dimension DIM.

If N >= size(X,DIM), DIFF returns an empty array.

Examples:

h=.001; x = 0:h:pi;

diff(sin(x."2))/h is an approximation to 2*cos(x.2).*x
diff((1:10)./2) is 3:2:19

If X=[375092]

then diff(X,1,1) is [-3 2 -3], diff(X,1,2) is[4 -2 9 -7],
diff(X,2,2) is the 2nd order difference along the dimension 2,
and diff(X,3,2) is the empty matrix.

Control Flow

* while —end
x=0;
while (x<5)
X=X+S;
disp(x);
End
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o if —else — elseif — end
a=6; %a=7; %a=10;
if (rem(a,3)==0)
a=a*3;
elseif (rem(a,2)==0)
a=a*2;

else

a=a*10;
end
disp (a);

+ switch — case — otherwise — end
x= input (‘The value of x:’);
units= input (‘Enter the unit of x: (Please Enter the unit between * ) ’);
switch units
case (‘inch’,’in’)
y=Xx*2.54;
case (‘feet’,’ft’)
y=x*2.54*12
case (‘meter’,’m’)
y=x*100 ;
case (‘millimeter’,’mm’)
y=x/10 ;
otherwise
disp (‘Unknown unit’);

end

[3]
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* break

for i=1:10
if (i>5)
break;
else
a=a*4.5;
end
end

disp (a);

Bessel Functions
BESSEL Bessel functions of various kinds.
Bessel functions are solutions to Bessel's differential
equation of order NU:
2 2 2
X*y"+ x*y'+(X-nu)*y=0

There are several functions available to produce solutions to
Bessel's equations. These are:

BESSELJ(NU,Z) Bessel function of the first kind
BESSELY(NU,Z) Bessel function of the second kind
BESSELI(NU,Z) Modified Bessel function of the first kind
BESSELK(NU,Z) Modified Bessel function of the second kind
BESSELH(NU,K,Z) Hankel function

[4]
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Examples

Example 1:

format long
z =(0:0.2:1);
bessely(1,z)

ans =
-Inf
-3.32382498811185
-1.78087204427005
-1.26039134717739
-0.97814417668336
-0.78121282130029

Example2:
format long

z=(0:0.2:1)}
besseli(1,z)
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Examples 3:

x=0:0.1:10;

for n=1:10
y=besselj(x,n);
plot(X,y)
grid on
hold on

end
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Input/output of Data from MATLAB Command Window

MATLAB remembers all input data in a session (anything entered through direct keyboard input or
running a script file) until the command ‘clear()’ is given or you exit MATLAB. One of the many features of
MATLAB is that it enables us to deal with the vectors/matrices in the same way as scalars. For instance, to
input the matrices/ vectors,

:|. cC=[1 —2 3 —4]

SRR A

type in the MATLAB Command window as below:

e

h
—

>>A=[123;456]
A=123
456
>>B = [3;-2;1]; %put the semicolon at the end of the statement to suppress the result printout onto the screen
>>C=[1-23-4]

At the end of the statement, press <Enter> if you want to check the result of executing the statement

immediately. Otherwise, type a semicolon “;” before pressing <Enter> so that your window will not be
overloaded by a long display of results [2].

Arithmetic Operations

+ Addition

Subtraction

Multiplication

Array multiplication

Left division

Array left division

Right division

-/ Array right division

Matrix or scalar raised to a power
-~ Array raised to a power

' Complex conjugate transpose
- ' Real transpose

[1]
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Basic Functions

Function
name

Function mean

clc Clear the command window

clear Clear workspace

who Show workspace

whos Show workspace in details

help Show information about any function

lookfor Search for a word in MATLAB files

Saving workspace

Loading saved workspace

Getting help

>> help function
>> help load
>> help save

[2]
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Readlnq Data
We can read a file containing a matrix by using the load function
load file_name.ext
File.ext is read into variable file_name, or
var =load(‘file name.ext”)
File is read into variable var
» File must be created 1 row/line, each element is separated by blank or tab or,
« Each line must contain equal no. of data

Writing Data to Disk
» We can write a file containing a matrix by using the save function
save file_name.ext —ascii var
var is written to file_name.ext in ASCII

Examples

save yyy.dat —asciia % write a to yyy.dat in
ASCII format
>> |oad xxX.txt
>>XXX

ooooooooooooooooooooooooooooooooooooooooooooo

..............................................

Variables
« MATLAB variables are arrays
» Variable must be one word
— myvariable accepted
— my variable not accepted
» Variable length is up to 31 character
« Variables must begin by a character
« MATLAB variables are case sensitive
» There are preserved variable names:

[3]
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ans Default function output

pi Pi=3.14

eps Very small value

inf Very large value = o as the result of (1/0)
NaN When the result = 0/0

realmin Minimum real number = 10°%x 2.2251
realmax Maximum real number = 10°®x 1.7977
nargin The number of input parameters

nargout

The number of output parameters

[4]
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MATLAB Environments

e Command window

Use Menus as an altemative to typing some commands

Use of Toolbar for easy access to popular operations

<) MATLAB Cormmand Window

File Edit Window Help
D& B ofPB R 2
Dy
r 3
M y NM
Command window
Status bar

Status of Caps, Num, and Scroll locks

[1]
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e \Workspace

Number of bytes in the matrix

size of the matnx

Name of the matnx -
Type of the matnix
» Workspace Browser
Name * S-:* ‘M Class ‘
fita w3 24 double anyy
i 23 48 double anay
e 10 10 chy sy
md "2 256 cel iy
E.mw-zsm-mmm

\ \

Delete the selected matrix Close the workspace browser
from the workspace

Open the selected matrix .
Displays the total number of

elements in the workspace
and total size of them.

[2]
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Current values: User can change the values o
thematnx s element by editing in the cell

MATLAB Editor/Debugger - [b]

§) Fle Edt Vew Debuy Took Window Heb -8 x
D&l B &Y &9 9408 | Suk| =
7
v |2 | s /]

W Py
lﬂ:r_4_J \ \ 12:52 P

Current dimension of the matnx: User can
change the dimensions of the matnx by
smply type the dimensions he/she want

Current Cell

Name of the matrx
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e Path browser

The directories in the path

The current Directory The Files in the selected path.

Fle Edt View Path Tools Hebp

= plx] 9|

Cumrent Directoey \ / Files in ME l
lx: \MATLABS\bin

ARBAY . BAT
Dol

check_save.
Code_Naxe.
Code_Nane.mat
] Cong.»
Cong.nat

9D I.n

) D_I.mat

fail 2.»

] his.n

] history.=»
history.mat

hral

e | ym
-wryoun ?

Remove the selected path

Addanew path ne_data.mat
] ok _2.m
Pass _2.»

R C2.n
E\MATLABS\toolbox\matlab\specgraph RC 2.mat
E:\MATLABS\toolbox\matlab\graphics ':'-2 i
E:\MATLABS\toolbox\matlab\uitools 5 Std-hu ~
E:\MATLABS\toolbox\matlab\str fun T
i \MATLABS\toolbox\matlab\iotun WhatTobo.n
B: \MATLABS\toolbox\matlab\time fun ) ¥hatToDo. mat
E:\MATLABS\toolbox\matlab\datatypes
E:\MATLABS\toolbox\matlab\winfun
E:\MATLABS\toolbox\natlab\dexnos
E:\MATLABS\toolbox\runtine

Ready 2:00 P
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e Editor window

DSE sB &7 @9 & s E
Automatic Color Highlighting
to Distinguish NP -
Different Elements .: ‘uﬁ::x:L:M 2l
5 Ammar A AL-F

function picecrop(AHimage)

i Changing the image matrix to a double precision

dimage=double (A\Himage) ;

t Determining the image size

[¥ y1= size(dimage]

el=1;
for i=1:ix)
for j=i:y:
if (dimage(i,))==1) hicl)=1i;
cl=cl+l;

end
end
cl=l;
for j=l:y:

for i=lix:

id Fdimemn 4 al==id fmSh-

@ et [Bepn-ee. | \
Ready 4 153
\ \ Automatic Indenting /

Names of the opened files in the editor Current line number
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e Figure window

¢ Figure b, 1
File Edt Tools Window Help

DEE&E YA/ AR

0.8

0

04

02

0

New figure

Open an exciting figure

) Rotate the plot
Save the current figure P

1 T Zoom the plot \ |

DEE&E NA2/ RO
/'/ \ : : 7

Start / End the plot editor mode

Draw aline in the plot
Type atextin the plot

Draw an arrow in the plot
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Basic triangular | Approximation | complex conversion
functions functions | functions functions functions
abs Ccos fix abs dec2hex
sqrt sin round angle dec2bin
mean tan floor conj dec2base
power acos ceil imag hex2dec
log asin rem real bin2dec
logl0 atan floor base2dec
exp csC ceil rad2deg
max sec rem deg2rad
min cot cart2sph
sort acsc cart2pol

asec pol2cart

acot sph2cart

cosh

sinh

tanh

[1]
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Relational and Logical Operators

Relational Operators

Operator name Symbol Comment

eq == equal

ne ~= not equal

It < less than

gt > greater than

le <= less than or equal

ge >= greater than or equal

Logical Operators

and & logical and
or | logical or
not ~ logical not

Xor logical exclusive or

[2]
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Matrix and Array
« Matrix = rectangular array of numbers
e 1-by-1 - scalar
e 1-by-nor n-by-1 - vector
* m-by-n - two-dim matrix
* ny-by-ny-by-n; ... = n-dim matrix

1. Solving Matrix Equations

Examplel:

x=[1 2 3; 45 6; 7 8 9];
v=[3;-6;1];

y=1nv (x) *v

Example2:

x = 0:25;

y = [exp(-.07*x) .*cos(x);exp(.05*x) .*cos (x)]"';

Example3:

x=[0 pi/10 2*pi; pi -pi 3*pi]
y=tan (x)

[3]
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Example4:

[10~3 104 1075 1076 107n7 1078]
X."2

X
Y

Example5:

x=-10:0.01:10;
y=cos ( (pi.*x*(2000/(5000+1000*cos (0.0002)))*sin(0.0002
))/0.0005*10~=-3) .72

IF Conditionally execute statements.The general form of the IF statement is

IF expression
statements

ELSEIF expression
statements

ELSE
statements

END

The statements are executed if the real part of the expression has all non-zero
elements. The ELSE and ELSEIF parts are optional. Zero or more ELSEIF parts
can be used as well as nested IF's. The expression is usually of the form expr rop
expr where ropis ==, <, >, <=, >=, or ~=,

[4]
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Example
if | ==
A(lJ) = 2;
elseif abs(I-J) ==
A(lJ) =-1;
else
A(1,J) =0;
end

ELSE is used with IF. The statements after the ELSE are executed if all the
preceding IF and ELSEIF expressions are false. The general form of the IF
statement is

IF expression

statements

ELSEIF expression

statements

ELSE

statements

END

[5]
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MATLAB Windows

We have already described the MATLAB Command Window and the Help
Browser, and have mentioned in passing the Command History window, Current
Directory browser, Workspace browser, and Launch Pad. These, and several other
windows you will encounter as you work with MATLAB, will allow you to: control
files and folders that you and MATLAB will need to access; write and edit the small
MATLAB programs (that is, M-files) that you will utilize to run MATLAB most
effectively; keep track of the variables and functions that you define as you use
MATLAB; and design graphical models to solve problems and simulate processes.
Some of these windows launch separately, and some are embedded in the Desktop.
You can dock some of those that launch separately inside the Desktop (through the
View: Dock menu button), or you can separate windows inside your MATLAB
Desktop out to your computer desktop by clicking on the curved arrow in the upper
right.

Typing in the Command Window

Click in the Command Window to make it active. When a window becomes
active, its title bar darkens. It is also likely that your cursor will change from outline
form to solid, or from light to dark, or it may simply appear. Now you can begin
entering commands [1].
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Double click on the MATLAB shortcut

MATLAB

T'he Language of Technical Computing
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Figure 1-1: A MATLAB Desktop
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Quitting MATLAB
» Select File > Exit MATLAB in desktop
*  Or type quit at prompt “>>¢ in command window
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Overview
« MATLAB = Matrix Laboratory.
» To provide easy access to software developed by LINPACK and
EISPACK projects.
* Incorporate LAPACK and BLAS lib. for matrix computation.
» Features add-on applications-specific called toolboxes.

The MATLAB System

+ Desktop tools &development environment — tools and facilities to
help users use and become more productive

Mathematical function lib.-large collection of computational
algorithms

The language- high-level language with control flow statements
Graphics — facilities for data visualization

External interfaces — can be used with other programming
language like C or FORTRAN.

Reference

[1] B. Hunt, R. Lipsman, J. Rosenberg, K. Coombes, J Osborn and G. Stuck, “A
Guide to MATLAB for Beginners and Experienced Users”, John Wiley &
Sons,2001.
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STEM Function

STEM Discrete sequence or "stem" plot. STEM(Y) plots the data sequence Y as stems from the x axis
terminated with circles for the data value. If Y is a matrix then each column is plotted as a separate series
STEM(X,Y) plots the data sequence Y at the values specified in X. STEM(...,'filled") produces a stem plot
with filled markers. STEM(...,'LINESPEC") uses the linetype specified for the stems and markers. See
PLOT for possibilities. STEM(AX,...) plots into axes with handle AX. Use GCA to get the handle to the
current axes or to create one if none exist. H= STEM(...) returns a vector of stem series handles in H, one
handle per column of datain.

Examples

Single Series of Data

This example creates a stem plot representing the cosine of 10 values linearly spaced between 0 and 27. Note
that the line style of the baseline is set by first getting its handle from the stemseries object's BaseLine
property.

t = linspace(-2*pi,2*pi,10);

h = stem(t,cos(t), fill',’--");

set(get(h,'BaseLine"),'LineStyle’,".")

set(h,'MarkerFaceColor','red’)

1
0.8 !
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0.4 b

T !
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Two Series of Data on One Graph
The following example creates a stem plot from a two-column matrix. In this case, the stem function creates
two stemseries objects, one of each column of data. Both objects' handles are returned in the output argument
h.
h(1) is the handle to the stemseries object plotting the expression exp(-.07*x).*cos(x).
h(2) is the handle to the stemseries object plotting the expression exp(.05*x).*cos(x).
X =0:25;
y = [exp(-.07*x).*cos(x);exp(.05*x).*cos(X)]';
h = stem(x,y);
set(h(1),'MarkerFaceColor','blue’)
. set(h(2),'MarkerFaceColor','red’,'Marker','square")

r r r r
o 5 10 15 20 25

Three-Dimensional Stem Plots

stem3 displays 3-D stem plots extending from the xy-plane. With only one vector argument, the stems are
plotted in one row at x = 1 or y = 1, depending on whether the argument is a column or row vector. stem3 is
intended to display data that you cannot visualize in a 2-D view.

[2]


jar:file:///C:/Program%20Files/MATLAB/R2009b/help/techdoc/help.jar%21/ref/stem3.html

University of Technology
Laser and Optoelectronics Engineering Department

i)
! 9V0 diw Saaly

Computer Applications

Example — 3-D Stem Plot of an FFT
Fast Fourier transforms are calculated at points around the unit circle on the complex plane. It is interesting

to visualize the plot around the unit circle. Calculating the unit circle

th = (0:127)/128*2*pi;

X = cos(th);

y = sin(th);

and the magnitude frequency response of a step function. The command

f = abs(fft(ones(10,1),128));

displays the data using a 3-D stem plot, terminating the stems with filled diamond markers:
stem3(x,y,f','d", fill")

view([-65 30])

Magnitude Frequency Response
—
e

Amplitude

Imaginary

[3]
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Fourier Transform

A theorem of mathematics says, roughly, that any function can be represented as a sum of
sinusoids of different amplitudes and frequencies. The Fourier transform is the mathematical
technique of finding the amplitudes and frequencies of those sinusoids. The Discrete Fourier
Transform (DFT) is an algorithm that calculates the Fourier transform for numerical data.
The Fast Fourier Transform is an efficient implementation of the DFT. The following
functions are available in mat lab to do Fourier transforms and related operations:

fourier

Fourier integral transform
Syntax
F = fourier(f)
F = fourier(f,v)
F = fourier(f,u,v)
Description
F = fourier(f) is the Fourier transform of the symbolic scalar f with default independent variable x.
The default return is a function of w. The Fourier transform is applied to a function of x and returns a
function of w.
If f="f(w), fourier returns a function of t.

[4]
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Laplace transform

laplace(F)

laplace(F, t)

laplace(F, w, z)

L = laplace(F) isthe Laplace transform of the scalar symbol F with default independent variable t.

The default return is a function of s. The Laplace transform is applied to a function of t and returns a function

of s.

Example
symsat;
fl=t"4;
f2=1/sqrt(t);
f3=exp(a*t)

L1 = laplace(fl)
L2 = laplace(f2)
L3= laplace(f3)

[5]
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Simulink

Introduction

Simulink is a software package that enables you to model, simulate, and analyze systems whose outputs
change over time. Such systems are often referred to as dynamic systems. The Simulink software can be used
to explore the behavior of a wide range of real-world dynamic systems, including electrical circuits, shock
absorbers, braking systems, and many other electrical, mechanical, and thermodynamic systems. This section
explains how Simulink works.

Simulating a dynamic system is a two-step process. First, a user creates a block diagram, using the Simulink
model editor, that graphically depicts time-dependent mathematical relationships among the system's inputs,
states, and outputs. The user then commands the Simulink software to simulate the system represented by the
model from a specified start time to a specified stop time.

Block Diagram Semantics

A classic block diagram model of a dynamic system graphically consists of blocks and lines (signals). The
history of these block diagram models is derived from engineering areas such as Feedback Control Theory
and Signal Processing. A block within a block diagram defines a dynamic system in itself. The relationships
between each elementary dynamic system in a block diagram are illustrated by the use of signals connecting
the blocks. Collectively the blocks and lines in a block diagram describe an overall dynamic system.

The Simulink product extends these classic block diagram models by introducing the notion of two classes of
blocks, nonvirtual blocks and virtual blocks. Nonvirtual blocks represent elementary systems. Virtual blocks
exist for graphical and organizational convenience only: they have no effect on the system of equations
described by the block diagram model. You can use virtual blocks to improve the readability of your models.

[1]
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Creating an Empty Model :: Creating a Model (Simulink®) jar:file:///C:/Program%20F iles/MATLAB/R2009b/help/toolbox/simulink. .

Creating an Empty Model

To create an empty model, click the New button on the Library Browser's toolbar, or choose New from the library
window's File menu and select Model. An empty model is created in memory and it is displayed in a new model editor
window.

Ry
Creating a Model Template

When you create a model, Simulink uses defaults for many configuration parameters. For example, by default new
models have a white canvas, the cde45 solver, and a visible toolbar. If these or other defaults do not meet your needs,
you can use the Simulink software model construction commands described in Model Construction to write a function that
creates a model with the defaults you prefer. For example, the following function creates a model that has a green canvas
and a hidden toolbar, and uses the ode3 solver:

function new model (modelname)

% NEW MODEL Create a new, empty Simulink model

B NEW MODEL { 'MODELNAME') creates a new model with
the name 'MODELNAME'. Without the 'MODELNAME'
argument, the new model i1s named "'my untitled’.

oe

oo

if nargin ==
modelname = 'my untitled':
end

% create and open the model
open system(new system(modelname)) ;

% set default screen color
set param(modelname, 'ScreenColor', "green');

% set default solver
set param{modelname, '"Solver', Tode3");

% set default toolbar visibility
set param(modelname, 'Toclbar', 'off'):

o

% save the model
save system(modelname) ;

lof2 04/03/2011 09:02 La
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Selecting Objects :: Creating a Model (Simulink®) jar:file:///C:/Program%20Files/MATL AB/R2009b/help/toolbox/simulink. ..

Selecting Objects

On this page...

Selecting an Object
Selecting Multiple Objects

Selecting an Object

To select an cbject, click it. Small black square handles appear at the corners of a selected block and near the end
points of a selected line. For example, the figure below shows a selected Sine Wave block and a selected line.

Y
Sine fara

When you select an object by clicking it, any other selected objects are deselected.

Selecting Multiple Objects

You can select more than one object either by selecting objects one at a time, by selecting objects located near each
other using a bounding box, or by selecting the entire model.

Selecting Multiple Objects One at a Time

To select more than one object by selecting each object individually, hold down the Shift key and click each object to be
selected. To deselect a selected object, click the object again while holding down the Shift key.

Selecting Multiple Objects Using a Bounding Box

An easy way to select more than one object in the same area of the window is to draw a bounding box around the
objects:

1. Define the starting corner of a bounding box by positioning the pointer at one corner of the box, then pressing and
holding down the mouse button. Notice the shape of the cursor.

_.l_
Ft——{

Sine Wave

Scope

2. Drag the pointer to the opposite corner of the box. A dotted rectangle encloses the selected blocks and lines.

e

Sine Wave

Scope

3. Release the mouse button. All blocks and lines at least partially enclosed by the becunding box are selected.
L]

Sooape

Sine Wiave

Selecting All Objects

lof2 04/03/2011 09:07 L=
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Connecting Blocks :: Creating a Model (3imulink®) jar:file.///C:/Program%20Files/MATLAB/R2009b/help/toolbox/simulink...

Connecting Blocks

On this page...

Automatically Connecting Blocks
Manually Connecting Blocks
Disconnecting Blocks

Automatically Connecting Blocks

You can command the Simulink software to connect blocks automatically. This eliminates the need for you to draw the
connecting lines yourself. When connecting blocks, the lines are routed around intervening blocks to avoid cluttering the
diagram.

Connecting Two Blocks

To autoconnect two blocks:

1. Select the source block.

Lot

t
Sinelgave
}
Constant Gain
R
=
Irtcaegratss

2. Hold down Ctrl and left-click the destination block.

The source block is connected to the destination block, and the lines are routed around intervening blocks if
necessary.

P
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P
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VWWhen connecting two blocks, the Simulink software draws as many connections as possible between the two blocks as
illustrated in the following example.
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Before autoconnect After auloonned

Connecting Groups of Blocks
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Aligning, Distributing, and Resizing Groups of Blocks Automatically :: ... jar:file:///C:/Program%20Files/MATLAB/R2009b/help/toolbox/simulink...

Aligning, Distributing, and Resizing Groups of Blocks Automatically

The model editor's Format menu includes commands that let you quickly align, distribute, and resize groups of blocks.
To align (or distribute or resize) a group of blocks:

1. Select the blocks that you want to align.

[¢]
1

et nd Soome

LR

One of the selected blocks displays empty selection handles. The model editor uses this block as the reference for
aligning the other selected blocks. If you want another block to serve as the alignment reference, click that block.
2. Select one of the alighment options from the editor's Format > Align Blocks menu (or distribution options from

the Format > Distribute Blocks or resize options from the Format > Resize Blocks menu). For example,
selecting Align Top Edges alighs the top edges of the selected blocks with the top edge of the reference block.

- G =1
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Provide feedback about this paae
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Starting Simulink Software :: Simulink Basics (Simulink®) jar:file:///C:/Program%620Files/MATLAB/R2009b/help/toolbox/simulink. ..

Starting Simulink Software

To start the Simulink software, you must first start the M/"—\TLAB® technical computing environment. Consult your
MATLAB documentation for more information. You can then start the Simulink software in two ways:

+ On the toolbar, click the Simulink icon. E
+ Enter the simulink command at the MATLAB prompt.

The Library Browser appears. It displays a tree-structured view of the Simulink block libraries installed on your system.
You build models by copying blocks from the Library Browser into a model window (see Editing Blocks).

The Simulink library window displays icons representing the pre-installed block libraries. You can create models by
copying blocks from the library into a model window.
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Note On computers running the Windows® operating system, you can display the Simulink library window by
right-clicking the Simulink node in the Library Browser window.

Provide feedback about this page
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Panning Block Diagrams :: Simulink Basics (Simulink®) jar:file.///C:/Program%20F iles/MATLAB/R2009b/help/toolbox/simulink. ..

Panning Block Diagrams

You can use your keyboard alone (see Model Viewing Shortcuts ) or in combination with your mouse to pan model
diagrams that are too large to fit in the Model Editor's window. To use the keyboard and the mouse, position the mouse
over the diagram, hold down the p or q key on the keyboard, then hold down the left mouse button.

Note You must press and hold down the key first and then the mouse button. The reverse does not work.

A pan cursor appears.

Fan cursor

van der Pol Equaliion

3

BN
P
i P > E?,M“ L
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g

e

Moving the mouse now pans the model diagram in the editor window.

Provide feedback about this page
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